Contents

What’s New in the SAS Cloud ........................................... v
Accessibility ................................................................. vii

Chapter 1 • Overview of SAS App Central and Administration Tasks ................................................. 1
  Introducing the SAS Cloud ........................................... 1
  Getting Started with Administration Tasks ................. 1
  Ongoing Administration Tasks ...................................... 2
  Your First Look at SAS App Central ............................ 3
  Navigating the SAS Cloud and SAS App Central .......... 4
  Introducing SAS Management Console .......................... 4
  Introducing SAS vApp Ledger ....................................... 5

Chapter 2 • Viewing Account Information ........................................... 7
  Overview of Account Information ................................. 7
  Assets .................................................................... 8
  Reports and Logs ....................................................... 9

Chapter 3 • Managing Users ................................................. 11
  About Managing Users .............................................. 11
  Adding Users ........................................................... 12
  Invite New Users ....................................................... 13
  Email Users .............................................................. 14
  Download User Data .................................................. 14
  View User Information ............................................... 15
  Managing Users’ SAS App Central Roles ....................... 15
  Managing Users’ Access to SAS Environments ............... 17
  Suspend or Activate a User ......................................... 18
  Delete Users ............................................................ 18

Chapter 4 • Managing Environments ........................................... 19
  About Environments .................................................. 19
  View Environment Information .................................... 20
  Edit Environment Identification Information ................. 20
  Assign Users to an Environment .................................... 21

Chapter 5 • Managing News ................................................. 23
  About News Stories .................................................... 23
  Create a News Story ................................................... 23
  Edit a News Story ....................................................... 23
  Delete a News Story ................................................... 24

Chapter 6 • Managing Email Templates ........................................... 25
  About Email Templates .............................................. 25
  Create an Email Template .......................................... 25
  Edit and Preview an Email Template .......................... 26
  Delete an Email Template ......................................... 27

Chapter 7 • Uploading Data ................................................. 29
  About Uploading and Managing Data ............................ 29
### Contents

Upload and Manage Data with SAS vApp Data Manager ........................................ 29
Upload Data via SFTP ......................................................................................... 31

**Chapter 8 • Administering SAS: The Basics** .................................................. 33
Overview of SAS Administration ................................................................. 33
Open SAS Management Console ................................................................. 36
Create a Connection Profile ......................................................................... 38
Assign Users to Groups and Roles ................................................................. 38
Create and Manage Folders ........................................................................... 39
Viewing and Assigning Permissions .............................................................. 39
What’s New in the SAS Cloud

July 2018 Enhancements to SAS App Central

In July 2018, the user interface for SAS App Central was updated to improve usability and visual appeal. This document was updated to address the changes in the user interface. The usage of SAS App Central is unchanged.
Accessibility

For information about the accessibility of this product, see Accessibility Features of SAS App Central.
What's New in the SAS Cloud
Chapter 1
Overview of SAS App Central and Administration Tasks

Introducing the SAS Cloud

The SAS Cloud is a private cloud hosted by SAS Solutions OnDemand that provides ready access to and easy management of SAS software. Customers can use applications in the SAS Cloud without investing the time and resources that are required to support their own SAS installation.

Within the SAS Cloud, your organization is licensed to use one or more dedicated SAS environments. A SAS environment is a complete, self-contained, fully functioning deployment of SAS applications. Environments in the SAS Cloud are deployed using virtualization technology, which makes the environments easy to create and manage. A typical environment includes the following:

- data storage that can be populated with your organization’s data
- virtualized software, servers, and services that perform various types of processing
- virtualized client applications through which users can access SAS functionality
- administrative interfaces for uploading data, organizing SAS content, and managing permissions

Getting Started with Administration Tasks

As an account administrator for your organization, you are responsible for several quick and easy administrative tasks. Here is a suggested sequence of tasks to get you started:
1. Log on to the SAS Cloud by following the instructions in your invitation email.

2. Explore SAS App Central, which appears in your browser when you first log on.
   
   For details, see “Your First Look at SAS App Central” on page 3 and “Navigating the SAS Cloud and SAS App Central” on page 4.

3. Try out your SAS applications. Access them on the Home page of SAS App Central, under the My Applications section. The applications that you can access depend on which roles you are assigned to.

4. Add users to your SAS Cloud account. You specify users’ email addresses, assign users to administrative roles, and specify the SAS environments that each user is allowed to access. For details, see Chapter 3, “Managing Users,” on page 11.
   
   When you first add users to your account, they have the status of Onboarding. Each new user receives an invitation email with logon instructions. The user’s status changes to Active after that user logs on for the first time.

5. Upload data to the SAS Cloud. The data is stored in a secured location that is associated with a particular SAS environment within your SAS Cloud account.
   

6. Administer your SAS applications. You might need to set up user groups, assign application roles to users, create folders to manage SAS content, and assign user permissions to content. See Chapter 8, “Administering SAS: The Basics,” on page 33.
   
   Additional administration tasks might be required, depending on which SAS applications you have licensed. For details, see the relevant SAS documentation.

---

### Ongoing Administration Tasks

After you have added users and assigned them to environments, you are responsible for the following ongoing administration tasks:

- Add and remove users as needed, and assign users to roles and to new SAS environments. See Chapter 3, “Managing Users,” on page 11.
- Communicate with users through emails and news items. See the following topics:
  - Chapter 5, “Managing News,” on page 23
  - “Email Users” on page 14
  - Chapter 6, “Managing Email Templates,” on page 25
- Report issues to SAS Technical Support for resolution as needed. For details, access the SAS Support link on the SAS App Central Home page.

Other ongoing administration tasks might be required, depending on which SAS applications you have licensed. For details, see the relevant SAS documentation.
After you log on to the SAS Cloud, the SAS App Central application appears in your browser, as shown in the following example:

The Home page is displayed to all users, regardless of their assigned roles. Here are features of the Home page:

1. Tabs enable you to access different areas of functionality within SAS App Central. Account administrators can see the Home, Account, Users, Environments, News, and Email Templates tabs.
   
   Other users can see only the Home tab.

2. The title banner includes the account name to the left of the user name, and the icon that opens the main menu.

3. The application banner displays a heading and a message from your SAS provider administrator. Click the heading to display the message.

4. The My Applications section contains icons for each accessible SAS application, based on your assigned roles. If you can access multiple environments, then a separate application group appears for each environment.
To open an application, click its icon. If the application is web-based, it opens in a new tab in your browser. Desktop applications are downloaded to your local machine.

5 News items are created by your organization’s account administrators specifically for your users. Use the News tab to create, edit, and delete news items. News can be published for any purpose (for example, to announce newly licensed SAS products, to provide tips for using the SAS Cloud, or to publish news that is unrelated to SAS).

6 The application footer includes several links to help you connect with other SAS users.

Navigating the SAS Cloud and SAS App Central

Here are some general instructions for navigating the SAS Cloud and SAS App Central:

- To refresh a page with the most up-to-date information, press the F5 key.
- To start an application, go to the My Applications section of the SAS App Central Home page, and click the application’s icon. If the application is web-based, it opens in a new tab in your browser. Desktop applications are downloaded to your local machine.
- To log off from a web application, close the browser window in which the application appears. To log off from a desktop application, select File ➤ Exit in the application’s menu bar.
- To use the Users, Environment, News, and Email Templates tabs, do the following:
  - To sort a list of items based on the values in a column, click the appropriate column heading. You can sort on only one column at a time. Sorting is not enabled for all columns.
  - To display additional items, click a page number or click Next.
  - To view or edit details about an item, click the item’s name. To return to the list from a detail page, click Back to list-name in the upper right corner of the page.
  - To delete one or more items, select the check box to the left of each item that you want to delete. Then click .
- To log off from SAS App Central, click the Menu icon ( ) in the upper right corner, and then select Sign Out.

Introducing SAS Management Console

SAS Management Console is a desktop application that enables the administration of SAS applications. Use SAS Management Console for tasks such as the following:

- organizing users into groups.
- assigning users and groups to SAS application roles. Roles control the availability of application features such as menu items.
Introducing SAS vApp Ledger

In the SAS Cloud, some SAS applications (such as SAS Visual Analytics) are packaged as vApps. SAS vApp Ledger is software that handles the configuration of these applications across an environment’s virtual machines. It then collects information about the environment so that users and calling programs can retrieve the information when needed.

CAUTION: In most cases, you should use SAS App Central, not SAS vApp Ledger, to manage your environments. As a best practice, use SAS vApp Ledger only when you are requested to do so by SAS Technical Support. SAS vApp Ledger is available only to users who are assigned to the SAS administrator role.
Chapter 2
Viewing Account Information

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Account Information</td>
<td>7</td>
</tr>
<tr>
<td>Assets</td>
<td>8</td>
</tr>
<tr>
<td>Reports and Logs</td>
<td>9</td>
</tr>
<tr>
<td>Using and Viewing Reports and Logs</td>
<td>9</td>
</tr>
<tr>
<td>User Activity Report</td>
<td>9</td>
</tr>
<tr>
<td>Application Activity Report</td>
<td>9</td>
</tr>
<tr>
<td>Email Activity Report</td>
<td>9</td>
</tr>
<tr>
<td>Usage Summary Report</td>
<td>9</td>
</tr>
</tbody>
</table>

Overview of Account Information

A variety of statistics, reports, and logs are available that enable you to monitor usage of your SAS Cloud account and of the applications in your SAS environments. Information is available in both summary and detailed formats. To access this information, open the Account tab in SAS App Central:
The top of the tab displays basic information about your account. This information is maintained by SAS.

Assets

The Assets section on the Account tab displays the following information about your organization’s account:

- the current number of users. Click this item to go to the Users tab.
- the current number of pending or active environments. Click this item to go to the Environments tab.
- the number of news stories that are displayed on the Home page of SAS App Central. Click this item to go to the News tab.
- the number of email message templates and email letterhead templates that are available in SAS App Central. Click either of these items to go to the Email Templates tab.
Reports and Logs

Using and Viewing Reports and Logs

Use the Reports and Logs section of the Account tab to obtain summary and detail information about activity in your SAS Cloud account. To view a report or log, click its name.

Here are some general instructions for viewing reports and logs:

- To sort the data based on the values in a column, click the appropriate column heading. You can sort on only one column at a time. Sorting is not enabled for all columns.
- To display additional pages, click a page number or click Next at the bottom of the report.
- To download the report information to a comma-separated values (CSV) file on your computer, click  
- To return to the Account page, click Back to Account in the upper right corner of the page.

The reports are described in the following topics.

User Activity Report

The User Activity report provides a detailed listing of user activity that has occurred in your SAS Cloud account.

The report lists activities such as logging on and off, the creation and updating of user accounts, onboarding, application usage, and emailing. For each action, the report displays the date and time, the user’s email address, and the action that was performed.

Application Activity Report

The Application Activity report provides details about the usage of the applications in your SAS environments. Every time a user accesses an application from SAS App Central, this report records the date and time, the application name, and the user’s email address.

Email Activity Report

The Email Activity report provides details about emails that have been sent from SAS App Central. These emails include ad hoc messages as well as invitation messages.

For each email, the log shows the date and time, the sender’s email address, the time, the recipients, and the subject.

Usage Summary Report

The Users section of the Usage Summary report displays the following information:
• the number of unique visitors who logged on to your SAS Cloud account today and year-to-date
• the total number of visits (logon events) to your SAS Cloud account today and year-to-date

For details about these visitors and visits, see the User Activity report.

The Applications section of the Usage Summary report displays the following information:
• the number of users who have accessed the most frequently used application
• the number of users who have accessed the least frequently used application

For details about application usage, see the Application Usage report.
As an account administrator, you are responsible for managing users’ access to your SAS Cloud account. The user management tasks include the following:

- add users to your organization’s account
- send invitation emails to new users
- send other emails to users
- download a comma-separated values (CSV) file of user information
- assign users to roles
- give users access to SAS environments
• suspend and reactivate users
• delete users from your account

You perform all of these tasks on the Users tab in SAS App Central:

When you first add users to your account, their status is Onboarding. Each new user receives an invitation email with logon instructions. The user’s status changes to Active after the user logs on for the first time.

Adding Users

You can enter users’ information manually, or you can upload a file containing a list of users.

Add Users Manually

To add users manually:

1. On the Users tab, click Add Users.
2. In the Add Users window, enter email addresses for up to five users.
3. Select the Send invitations check box if you want invitation emails to be sent immediately to these users.
   T I P If you choose not to send the emails now, you can send them later. See “Invite New Users” on page 13.
4. Click Add.
5. Repeat steps 2 through 4 until you have added all of your users.
6. If you want to designate any of the new users as account administrators, data administrators, or SAS administrators, see “Managing Users’ SAS App Central Roles” on page 15.

Upload User Data

To upload a CSV file that contains the users’ email addresses:

1. Create a file that contains an email address for each user. If the file contains data other than email addresses, uses commas to separate the data elements. Here is an example:
2. On the Users tab, click \( \text{} \).

3. In the Upload Users window, do the following:
   a. Click the displayed button (for example, Browse or Choose File) to navigate to the file that you created in step 1. Then click Open.
   b. Enter the column number that contains the email addresses. For example, in the file that is shown in step 1, the email addresses are in column 3.
   c. If the first row of the file contains header information and is to be ignored, select the First row is a header check box.
   d. Select the Send invitations check box if you want invitation emails to be sent immediately to the new users.
      
         **T I P**  If you choose not to send the emails now, you can send them later. See “Invite New Users” on page \( 13 \).
   e. Click Upload and Add.

4. If you want to designate any of the new users as account administrators, data administrators, or SAS administrators, see “Managing Users’ SAS App Central Roles” on page \( 15 \).

---

**Invite New Users**

When you add or upload user data to your account, you can select the Send invitations check box to immediately send invitation emails to the new users. The email welcomes the user to the SAS Cloud and provides instructions for logging on. The email uses the standard invitation template (TenantUser_EmailInvite.st) for your account’s preferred locale.

You can choose to send invitations separately, after users have been added.

1. On the Users tab, click \( \text{} \).

2. Select Send Invitations. The Send Invitations window appears.

3. (Optional) Select Omit users who were previously invited. By default, invitations are sent to all users with a status of Onboarding. This status means that the user has been added but has not yet joined (logged on). Some onboarding users might have already received invitations. Select this check box if you do not want the previously invited users to receive another invitation.

4. Click Send.

**T I P**  On the Email Templates tab, you can preview the invitation emails and customize them for your account. See Chapter 6, “Managing Email Templates,” on page \( 25 \).
Email Users

Besides invitation emails, you can send other emails to users from SAS App Central as needed. For example, you might want to email users when a new SAS application becomes available.

**TIP**
To simplify emailing, you can create your own locale-specific email templates with predefined letterheads, formatting, variables, and text. See Chapter 6, “Managing Email Templates,” on page 25.

To send an email (either free-form or based on a template):

1. On the Users tab, click and select **Send Email**.

2. If you want to use an email template, complete these steps:
   a. On the Send Email page, select a locale for the message.
   b. In the **Template** drop-down list, select the template that you want to use. The list includes all of the available templates for the selected locale.

   The template content is displayed on the subject line and in the message box.

3. To specify the recipients, click **Select** next to the **To** field.

   In the Email Recipients window, use the check boxes to specify which users are to receive the email. To send the email to all users, select the check box in the first row.

   Click **OK**.

4. Enter or edit the subject line.

5. Enter or edit the message text in both HTML and text formats, using the **Message type** radio buttons to toggle between the two formats. You can include the following variables in the message:

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$USER_NAME$</td>
<td>The email address of the user receiving the email.</td>
</tr>
<tr>
<td>$CLOUD_URLS$</td>
<td>The URL that your organization uses to access the SAS Cloud.</td>
</tr>
<tr>
<td>$ACCOUNT_NAME$</td>
<td>The name of your SAS Cloud account.</td>
</tr>
</tbody>
</table>

6. Click **Send**.

Download User Data

Click on the Users tab to download the information that is listed on the Users tab to a CSV file on your computer.
View User Information

To view or update information for a particular user, click the user’s email address in the list of users on the Users tab.

The user’s information page appears:

![User Information Page]

You can perform the following tasks on this page:

- assign the user to one or more roles
- manage the user’s access to SAS environments
- suspend or reactivate the user
- delete the user

Managing Users’ SAS App Central Roles

About SAS App Central Roles

Roles determine what users can do in SAS App Central and in your organization’s SAS environments.

The following table identifies which tasks each role can perform in SAS App Central. It also lists the groups that the users in these roles are automatically added to in their assigned environments. Based on their group memberships, users are assigned to specific application-level roles in the environment.
### Assigned Users to SAS App Central Roles

By default, all users are assigned to the SAS user role in SAS App Central. To assign a user to an additional SAS App Central role (or to remove a user from a role):

1. On the **Users** tab, click the user’s email address.
2. In the **Roles** section of the user’s information page, click **Edit**.
3. In the Edit Roles window, select or clear the appropriate check boxes to specify roles for the user. To assign the user to all roles, select the check box in the first row.
4. Click **OK**.

*Note:* Users must be given access to one or more SAS environments before they can perform all of the tasks associated with their roles.

### Aligning SAS App Central Roles with Group Memberships in the SAS Environment

Occasionally, you might need to align a user’s group memberships in SAS metadata so that they correspond to the user’s role assignments in SAS App Central. For example, if you use SAS Management Console to add a user to (or to remove a user from) a group.
that corresponds to a SAS App Central role, that user’s memberships are out of alignment.

When memberships are out of alignment, an **Align Roles** button appears on the user’s information page. Click the button, and the appropriate adjustments to SAS metadata are made automatically.

If the **Align Roles** button continues to appear after alignment, contact SAS Technical Support for assistance.

**TIP** To avoid alignment issues, use SAS App Central rather than SAS Management Console to manage membership in the SAS Administrators group and other groups that correspond to SAS App Central roles. If you use SAS Management Console to manage memberships in these groups, your changes are overridden when realignment occurs.

**See Also**
Chapter 8, “Administering SAS: The Basics,” on page 33

---

**Managing Users’ Access to SAS Environments**

**About Assigning Users to Environments**

You can assign users to environments on either the **Users** tab or the **Environments** tab. After you assign user to an environment, the appropriate applications are added to the **My Applications** section of the user’s home page in SAS App Central. The applications that appear depend on users’ roles. For example:

- Only data administrators have access to SAS vApp Data Manager.
- Only SAS administrators have access to administrative applications such as SAS Management Console and SAS vApp Ledger.

If any of the applications require a metadata identity, the user’s ID is automatically added to SAS metadata. Within SAS metadata, users are automatically added to the appropriate groups and are given the appropriate permissions based on their role assignments in SAS App Central. For more information about metadata identities, see “About Metadata Identities” on page 34.

**Note**: The number of users that you can add to an environment depends on the service level for which your organization is licensed.

**Assign a User to One or More SAS Environments**

To give a user access to one or more SAS environments:

1. On the **Users** tab, click the user’s email address.
2. In the **Environments** section of the user’s information page, click **Edit**.
3. In the Edit Environments window, select or clear the appropriate check boxes to specify environments for the user. To assign the user to all environments, select the check box in the first row. Then click **OK**.
Assign Multiple Users to an Environment

Instead of assigning users to environments individually, you can use the Environments tab to assign multiple users to a particular environment.

To assign multiple users:
1. On the Environments tab, click the environment name.
2. In the Users section of the environment detail page, click Edit.
3. In the Edit Users window, select or clear the appropriate check boxes to specify which users can access the environment. (To give access to all users, select the check box in the first row.) Then click OK.

When you remove access for a user, the user’s SAS metadata identity is deleted from the environment if applicable. The user’s personal folder in SAS metadata is retained so that administrators can access it. If the user is re-added while the previous folder still exists, a new personal folder is created with (1) appended to the user name.

Suspend or Activate a User

To suspend a user’s access to your account:
1. On the Users tab, click the user’s email address.
2. Click Suspend at the top of the user’s information page.

*Note:* If the user has a metadata identity, the identity remains in metadata when the user is suspended.

To reactivate the user, click Activate.

Delete Users

To delete a user from your account:
1. On the Users tab, click the check box to the left of the user’s email address.
2. Click .
3. In the Confirm window, click Yes.

The user is deleted from SAS App Central and is also deleted from SAS metadata if the user has a metadata identity. The user’s personal folder in SAS metadata is retained so that administrators can access it. If the user is re-added while the previous folder still exists, a new personal folder is created with (1) appended to the user name.

*Tip:* You can also delete a user by clicking on the user’s information page.
Chapter 4
Managing Environments

About Environments

A SAS environment is a complete, self-contained, fully functioning deployment of SAS applications. Environments in the SAS Cloud are deployed by using virtualization technology. This technology makes environments easy to create and manage.

A typical environment includes the following:

• data storage that can be populated with your organization’s data
• virtualized software, servers, and services that perform various types of processing
• virtualized client applications through which users can access SAS functionality
• the following administrative interfaces:
  • SAS Management Console (for tasks such as assigning application roles, granting permissions, and organizing content)
  • SAS vApp Ledger, which provides a virtual machine-level view of applications that are packaged as vApps (for example, SAS Visual Analytics)
  • SAS vApp Data Manager, which enables you to upload data to a secured location for applications that are packaged as vApps (for example, SAS Visual Analytics)

SAS provides a ready-to-use environment for each SAS product that you have licensed. To manage the environment, you need to specify which of your organization’s users are authorized to access the environment. You can also edit the environment’s name and add a description.
View Environment Information

To see a list of your organization’s environments, click the **Environments** tab in SAS App Central. To view detailed information about an environment, click the environment name. A page similar to the following is displayed:

This page displays current status of the environment, the SAS applications that the environment includes, and the users who can access the environment.

Edit Environment Identification Information

1. Click **Edit** in the **Identification** section.

2. In the Edit Environment Identification window, you can do the following:
   - Edit the environment name. The name must be unique. If your account has more than one environment, the name is used in the **Applications** section of the **Home** tab to group applications.
   - Enter a description. The description is not shared with users.

3. Click **OK**.
Assign Users to an Environment

1. In the Users section on the Environment page, click Edit to edit the list of users who have access to the environment.

2. In the Edit Users dialog box, use the check boxes to specify which users can access the environment. (To give access to all users, select the check box in the first row.) Then click OK.

For more information about users’ access to environments, see “Managing Users’ Access to SAS Environments” on page 17.
Chapter 5
Managing News

About News Stories

News stories appear on the Home page of SAS App Central for all of the users in your organization’s account. As account administrator, you can create news stories for any purpose. For example, you can use news to announce newly licensed SAS products, to provide tips for using the SAS Cloud, or to publish news that is unrelated to SAS.

Create a News Story

To create a news story:

2. On the Create News Story page, enter a title for the story. Then enter the story in the Body section. You can use HTML tags for basic text formatting.
3. Click Preview to verify that the story appears as expected.
4. Click Create.
   The story appears on the home page for all of your account’s users.

Edit a News Story

To edit a news story, click its title in the list of stories on the News tab. On the Update News Story page, make your changes and click Save.
Delete a News Story

News stories are displayed indefinitely until you delete them. To delete a news story:

1. On the News tab, select the check box to the left of the story’s title.
2. Click Delete.
3. In the Confirm window, click Yes.
Chapter 6
Managing Email Templates

About Email Templates

Email templates contain predefined formatting, merge variables, and text. These templates simplify the process of creating emails to send to users from SAS App Central. Templates are locale-specific. You can create two types of templates:

message templates
contain formatting, merge variables, and text for the message body. SAS App Central provides one standard message template called TenantUser_EmailInvite.st, which is used to invite new users to join the SAS Cloud.

letterhead templates
contain formatting, merge variables, and text for the message header and footer. To use a letterhead template, you associate it with a message template. SAS App Central provides one standard letterhead template called Default_Letterhead.st, which is associated with the TenantUser_EmailInvite.st message template.

To manage templates, you can do the following in SAS App Central:

• create new templates for emails that you plan to send out frequently. For example, you can convert the standard templates to a different locale or create a new template for announcing the creation of a new SAS environment for your account.

• edit and preview existing templates. For example, you can customize the invitation message template by adding text that is specific to your organization or add your organization’s name to the default letterhead template.

Create an Email Template

To create a new email template:
1. On the Email Templates tab, select Message Templates or Letterhead Templates, depending on which type of template you want to create.

2. If you want to use an existing template as the starting point for the new template, select the locale of the template that you want to copy from the Locale list.

3. Click Create Message Template or Create Letterhead Template.

4. In the Create Message Template or Create Letterhead Template window, select an existing template from the Template to copy drop-down list.

   **TIP** The list includes only templates for the currently selected locale.

   **TIP** If you want to start with a blank template, select None.

5. Enter a name for the new template. The suffix .st is added if you do not include it.

   **TIP** If you specify a different locale, you can retain the current template name. If you create an invitation template for a different locale, be sure to retain the name TenantUser_EmailInvite.st.

   *Note:* Do not enter HTML tags in the Name or Description fields.

6. Select a locale for the new template.

7. Enter a description for the new template.

8. Click Create.

   The new template appears in the list on the Message Templates or Letterhead Templates page.

9. You can now edit and preview the new template.

---

**Edit and Preview an Email Template**

You can edit and preview the standard email templates or a new email template that you created.

1. On the Email Templates tab, select Message Templates or Letterhead Templates.

2. On the Message Templates or Letterhead Templates page, select the locale of the template that you want to edit or preview.

3. In the list of templates, click the name of the template that you want to edit or preview.

   The Edit page for the selected template is displayed.

4. Make the appropriate entries on the Edit page.

   • For message templates, you can do the following:
     • Edit the template description.
     • Edit the subject line. Be sure to use the locale that is associated with the template.
     • Select a letterhead template to be used with this message template. The drop-down box lists letterhead templates that have the same locale as the message template.
     • Edit the template body in both the HTML and text formats. SAS App Central sends emails as multipart messages that contain both formats. Recipients see
one of the two versions, depending on the rendering capabilities and user preference settings in the mail client.

Be sure to use the locale that is associated with the template.

You can include the following merge variables:

<table>
<thead>
<tr>
<th>Merge Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$USER_NAME$</td>
<td>The user name (email address) of the user receiving the email.</td>
</tr>
<tr>
<td>$CLOUD_URL$</td>
<td>The URL that your organization uses to access the SAS Cloud.</td>
</tr>
<tr>
<td>$ACCOUNT_NAME$</td>
<td>The name of your SAS Cloud account.</td>
</tr>
</tbody>
</table>

- For letterhead templates, you can do the following:
  - Edit the template description.
  - Edit the template body in both the HTML and text formats. Be sure to use the locale that is associated with the template.

In letterhead templates, you must include the following merge variable:

<table>
<thead>
<tr>
<th>Merge Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$S_SAS_TEMPLATE_BODY$</td>
<td>Placeholder for positioning the message template within the letterhead.</td>
</tr>
</tbody>
</table>

You can also use any of the merge variables that are valid in message templates.

5. Click **Preview** to verify that the message or letterhead appears as expected.

6. Click **Save** on the **Edit** page to save any changes that you made. The version number is automatically updated.

   **TIP** After saving the template, you might want to test it by sending an email to yourself to see how the variables resolve. See “Email Users” on page 14.

7. To return to the list of message templates or letterhead templates, click **Cancel**.

**See Also**

- “Invite New Users” on page 13
- “Email Users” on page 14

---

**Delete an Email Template**

To delete an email template:
1. On the **Email Templates** tab, select **Message Templates** or **Letterhead Templates**, depending on which type of template you want to delete.

2. On the Message Templates or Letterhead Templates page, select the locale of the template that you want to delete.

3. In the list of message templates or letterhead templates, select the check box to the left of the template’s name.

4. Click ![Select](image)

5. In the Delete Selected Items window, click **Delete**.

*Note:* You cannot delete the standard templates that are provided with SAS App Central.
Chapter 7
Uploading Data

About Uploading and Managing Data
Users who are assigned to the data administrator role can upload data to the SAS Cloud. For applications that are packaged as vApps (for example, SAS Visual Analytics), data administrators can use SAS vApp Data Manager for this task. In some cases, data administrators can use a Secure File Transfer Protocol (SFTP) client to upload data.

The data that you upload is stored in a secured location on the SAS Cloud that belongs exclusively to your account. If you have more than one SAS environment, each environment has its own separate storage area. An environment’s data can be accessed only by users that your account administrator has added to that environment. The type of access depends on the user’s role assignment:

- Users in the data administrator role can upload data to and download data from the environment’s SAS Cloud storage area.
- Users in the SAS administrator and SAS user roles can access data only through SAS applications in the environment. The level of access is controlled by permissions and role assignments in SAS metadata.

TIP To assign a user to the data administrator role, see “Managing Users’ SAS App Central Roles” on page 15.

TIP Some applications might require additional data loading procedures. For more information, see the relevant SAS documentation.

Upload and Manage Data with SAS vApp Data Manager
Data administrators can use SAS vApp Data Manager to upload and manage data for applications that are packaged as vApps (for example, SAS Visual Analytics).
Note: For the best user experience, use SAS vApp Data Manager in Google Chrome.

To upload data using SAS vApp Data Manager:

1. In the My Applications section of the SAS App Central Home page, click the SAS vApp Data Manager icon.

   Tip: If you are a data administrator for multiple SAS environments, be sure to select the icon from the application group for the appropriate environment.

   SAS vApp Data Manager appears in a new tab in your browser:

   ![SAS vApp Data Manager v2.0.2](image)

   **Manage Data Uploads**

2. In the left pane, navigate to the directory to which you want to upload the data.

   Tip: If you want to create a new directory within your Home directory, click New.

   Tip: If you have licensed SAS Visual Analytics and you want the data to be automatically loaded for use in that application, select your public directory.

3. Click at the top of the right pane. In the Microsoft Windows File Manager, navigate to the file that you want to upload, and click Open.

   The file is uploaded to the directory, and its filename and size are displayed in the right pane.

   Tip: Instead of using the Upload icon, you can drag files from the Windows File Manager to the right pane in SAS vApp Data Manager.

   The data is now available to applications that are in the selected SAS environment. To manage files that you have uploaded:

   • Click to download a file to your computer.

   • Click to delete a file or directory.
Upload Data via SFTP

Depending on which realm your SAS environment runs in, you might be able to use an SFTP client to upload data. If you are not sure whether SFTP is available for your environment, contact SAS Technical Support.

To upload data via SFTP:

1. Launch an SFTP client application such as WinSCP.
2. Log on as a user who has the data administrator role. Enter the following information:

<table>
<thead>
<tr>
<th>Host name</th>
<th>ssoclfsft.ondemand.sas.com</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>The first part of the user name (email address) that is associated with your SAS Profile, entered in lowercase letters. For example, if your user name is <a href="mailto:John.Smith@example.com">John.Smith@example.com</a>, then you would enter john.smith.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that is associated with your SAS Profile.</td>
</tr>
</tbody>
</table>

A directory tree is displayed with a directory for each SAS environment that is associated with your account.

3. Navigate to the directory for the SAS environment in which you want to load the data.
4. In the SAS environment directory, navigate to the public subdirectory.
5. Copy data files from your local computer to the public subdirectory.

The data is now available to applications in the selected SAS environment.
Overview of SAS Administration

Some SAS environments contain an administrative application called SAS Management Console. This application enables you to view and manage a central repository of metadata that is used by applications in your environment. The metadata repository is controlled by SAS Metadata Server. The repository contains information about the following:

- the data sources and data structures that are accessed by SAS applications in the environment
- other servers in the environment
- content that is created and used by SAS applications in the environment
- users and groups of users who are allowed to use the environment
- the levels of access that users and groups have to resources
This chapter provides basic information about using SAS Management Console.

Note: Depending on which SAS products you have licensed, you might need to perform other administration tasks either in SAS Management Console or in other SAS applications. For details, see your product documentation.

**SAS Management Console System Requirements**

When you click the SAS Management Console icon in SAS App Central, a copy of the SAS Management Console executable is downloaded to your computer. The executable can be run only in Microsoft Windows for x64 operating environments.

**About Metadata Identities**

A metadata identity is a metadata object that represents an individual user or a group of users in a SAS environment. Each individual and group that accesses secured resources on a SAS Metadata Server should have a unique metadata identity within that server.

When you use SAS App Central to give a user access to a SAS application that requires a metadata identity, the user’s identity is automatically created. The identity consists of a copy of the user name.

All of a user’s group memberships, application role memberships, and permission assignments are tied to the user’s metadata identity. Metadata identities enable administrators to audit individual actions in the metadata layer. The identities also provide personal folders for each user.

**About Groups**

A group is a set of users. The following two predefined groups are provided for SAS Cloud users:

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SASUSERS</td>
<td>Includes all users who have been assigned to applications that require metadata identities.</td>
</tr>
<tr>
<td>SAS Administrators</td>
<td>Enables users to perform metadata administration tasks.</td>
</tr>
</tbody>
</table>

You might have other predefined groups that pertain to specific SAS applications that you have licensed. Users are automatically added to the appropriate groups based on their role assignments in SAS App Central.

To simplify security management, you might want to create additional groups. Groups provide the following benefits:

- It is more efficient to assign permissions to groups than to individual users.
- It is sometimes more efficient to manage role membership by assigning groups to roles instead of by assigning users directly to roles.

**TIP** A group’s membership can include other groups as well as individual users. This enables you to create a nested group structure.

Users are automatically added to the appropriate groups in SAS metadata based on their role assignments in SAS App Central. When you change a user’s role assignments in
SAS App Central, the user’s corresponding group memberships are updated automatically in metadata.

**CAUTION:**

If you use SAS Management Console to add a user to (or remove a user from) a group that corresponds to a SAS App Central role, an out-of-alignment condition occurs. The membership change is overridden when roles are realigned. To avoid alignment issues, use SAS App Central rather than SAS Management Console to manage membership in the SASUSERS group, the SAS Administrators group, and other groups that correspond to SAS App Central roles.

For more information, see “Managing Users’ SAS App Central Roles” on page 15.

### About Roles in SAS Metadata

In SAS metadata, a role manages the availability of application features such as menu items.

An application feature that is under role-based management is called a capability. Anyone who is a member of a role has all of that role’s capabilities.

Each application that supports roles provides one or more predefined roles. Each predefined role has a unique initial set of capabilities. The capabilities that a role provides should reflect the activities and responsibilities of that role’s members. You can adjust the distribution of capabilities if needed.

Roles in SAS metadata are distinct from the roles that you assign to users in SAS App Central. When you assign users to roles in SAS App Central, the users are automatically assigned to the appropriate groups in SAS metadata. In turn, groups are assigned to specific roles in SAS metadata. You can use SAS Management Console to change these role assignments.

### About Folders

SAS applications use a hierarchy of SAS folders to store metadata for content such as tables, libraries, stored processes, and reports. These folders include personal folders for individual users, a folder for shared data, and folders for system content that is generally not accessed by users. Within this structure, you can create additional folders to meet your information management, data sharing, and security requirements.

The **Folders** tab of SAS Management Console displays all SAS folders that the user has permission to view. Most other client applications display SAS folders only if they contain content that is relevant to the application, subject to the user's permissions. The initial folder structure includes the following main components:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Folders</td>
<td>The root folder for the folder structure. This folder can contain other folders, but it cannot contain individual objects.</td>
</tr>
<tr>
<td>My Folder</td>
<td>A shortcut to the personal folder of the user who is currently logged on. See <strong>User Folders</strong> in this table.</td>
</tr>
<tr>
<td>Products</td>
<td>Contains folders for individual SAS products. These folders contain sample content that demonstrates product capabilities and that users can modify for their own purposes.</td>
</tr>
</tbody>
</table>
Folder | Purpose
---|---
Shared Data | Is provided for you to store user-created content that is shared among multiple users. You can create any number of subfolders to further organize content. You can also create additional shared folders directly under **SAS Folders**.

System | Contains SAS system objects. In SAS Cloud environments, these objects generally do not need to be accessed by users or account administrators.

User Folders | Contains folders that belong to individual users. These folders are referred to as users’ home folders and are designated with the user’s name. Each home folder contains a folder called **My Folder**. This folder is the standard location for storing content that the user creates.

**Note:** Do not delete or rename the folders **Products**, **System**, or **User Folders**. Also, do not delete or rename the home folder or personal folder of an active user. Maintaining these folders as directed helps ensure the integrity of your SAS environment.

**About Permissions**

SAS provides a metadata-based access control system that supplements protections in other layers, such as the operating system. Protections are cumulative across layers. You cannot perform a task unless you have sufficient access in all layers. The following table introduces the general-purpose permissions:

<table>
<thead>
<tr>
<th>Permission (Abbreviation)</th>
<th>Actions Affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReadMetadata (RM)</td>
<td>Viewing an object. For example, to see a report, you need the ReadMetadata permission for that report.</td>
</tr>
<tr>
<td>WriteMetadata (WM)</td>
<td>Editing, deleting, or setting permissions for an object. To delete an object, you also need the WriteMemberMetadata permission for the object's parent folder.</td>
</tr>
<tr>
<td>WriteMemberMetadata (WMM)</td>
<td>Adding an object to a folder or deleting an object from a folder. To enable someone to interact with a folder's contents but with not the folder itself, grant WMM and deny WM.</td>
</tr>
</tbody>
</table>

Users are automatically given appropriate permissions based on their role assignments in SAS App Central.

**Open SAS Management Console**

SAS Management Console is the primary interface for managing groups, roles, folders, and permissions for your SAS applications. To open SAS Management Console:

1. Make sure that your computer’s operating environment supports SAS Management Console. See “SAS Management Console System Requirements” on page 34.
2. Determine the host name for the servers in your SAS Cloud environment:
   a. In the My Applications section of the SAS App Central Home page, open a web-based SAS application (for example, SAS vApp Ledger).
      The application appears in a new tab in your browser. The address bar for the tab contains a URL in the following format:
      https://host-name/application-name/
   b. Make a note of the host name, which is typically in the form name1.name2.sas.com. You need this name in a later step.

3. In the My Applications section of the SAS App Central Home page, click the SAS Management Console icon.
   A copy of the SAS Management Console executable (SASManagementConsole.exe) is downloaded to your desktop.

4. Click Run or Open to run the executable; or save the executable, and then run it from its saved location.
   The following window appears:

5. In this window, do the following:
   a. Select the check box I need to proxy my access to SAS servers .
   b. In the Target System URL field, enter or paste the host name that you obtained in step 2. Enter it directly after the characters http://.
      TIP The correct protocol is http. Do not change it to https.
   c. Click Launch SAS Mgmt Console. The Connection Profile window appears.
   d. Click OK to connect to the environment’s SAS Metadata Server.
      The SAS Management Console application opens.

Note: If the connection fails, you might need to create a new connection profile. See “Create a Connection Profile” on page 38.
Create a Connection Profile

If you cannot connect to SAS Metadata Server, you might need to delete your connection profile and create a new one. To create a new connection profile:

1. In the Connection Profile window, select **Open an existing connection profile** and click **Delete**.
2. In the Delete Connection Profile window, click **Yes** to confirm the deletion.
3. In the Connection Profile window, select **Create a new connection profile** and click **OK**.
4. In the first window that appears, specify the connection name **My Server4** and select **Set this connection profile as the default**. Click **Next**.
5. In the next window, enter the following connection information:

<table>
<thead>
<tr>
<th>Machine</th>
<th>vsasmetadata.vapps.sas.com</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>8561</td>
</tr>
<tr>
<td>User ID and Password</td>
<td>The user name (email address) and password that you used to log on to the SAS Cloud</td>
</tr>
</tbody>
</table>

Click **Next**.
6. In the next window, click **Finish**.

The Connection Profile window appears with the new profile selected.
7. Click **OK** to connect with the new profile.

Assign Users to Groups and Roles

To access user administration features in SAS Management Console, select the **User Manager** node on the **Plug-ins** tab. The User Manager plug-in appears. Here are general instructions for using this plug-in:

- Users, groups, and roles are listed in the right pane. Use the check boxes to limit the list to just users, groups, or roles.
- To create a group, right-click the **User Manager** node and select **New ⇒ Group**.
- To view or change group membership, right-click the name of a group, select **Properties**, and click the **Members** tab in the Properties window.
- To view or change role membership, right-click the name of a role, select **Properties**, and then click the **Members** tab in the Properties window.

**Note:** Do not use SAS Management Console to add users. Instead, use SAS App Central. See “**Adding Users**” on page 12.
Create and Manage Folders

Within the SAS Folders hierarchy, you can create a customized folder structure that meets the information management, data sharing, and security requirements of your organization. You can set up folders under the Shared Data folder that is provided, or you can create additional folders under SAS Folders.

To create a folder:
1. Click the Folders tab in SAS Management Console.
2. Right-click the parent folder (the location where you want the folder to be created), and select New ➜ Folder.
3. In the New Folder Wizard, specify a name for the folder and click Finish.

To assign permissions to the folder, see “Viewing and Assigning Permissions” on page 39.

Here are some basic guidelines for creating folders:

• Keep the folder structure as simple as possible. A simple folder structure makes your system easier to navigate and easier to administer.
• Folders should be organized the way your work is organized. For example, you could set up folders for specific divisions or departments, specific business activities, or specific geographic regions.
• Develop a folder organization that reflects the access rules that you want to enforce. By assigning permissions to folders (rather than individual objects), you can easily restrict access to content.

To learn more about SAS folders, see Working with SAS Folders in SAS Intelligence Platform: System Administration Guide.
indicate that the permission comes from somewhere else (for example, a group, a parent object, or the unrestricted role).

**Assign Permissions**

To assign permissions for the currently selected object or folder:

1. On the **Authorization** tab, select a user or group. Alternatively, click **Add** to assign a permission to someone who is not listed.

2. In the **Effective Permissions** list box, select or clear check boxes to adjust the settings for the currently selected identity. Each click updates the object’s protections by either adding an explicit control or removing an existing explicit control. Removing an explicit control reveals an underlying grant or denial either from an ACT or from a group, a parent object, or the unrestricted role.

3. Repeat steps 1 and 2 for any other users or groups whose access to this object you want to adjust.

4. Review the settings for each identity in the **Users and Groups** list box. Settings that you add for a group can affect access for all members of that group. For example, a denial that you add for the PUBLIC group blocks access for all restricted users, unless there are other explicit or ACT (green) grants. You must offset a broad explicit denial with explicit or ACT grants for any restricted identities whose access you want to preserve.

5. Click **OK** to save the settings.

To learn more about assigning permissions, see *Access Management Tasks* in *SAS Management Console: Guide to Users and Permissions*.

**Tips for Assigning Permissions**

Here are some important tips for assigning permissions:

- To obtain a thorough understanding of access management concepts and procedures, review the *SAS Management Console: Guide to Users and Permissions*.

- When possible, assign permissions to groups rather than to individual users.

- Create a folder structure that reflects the access distinctions that you want to make. Then, instead of setting permissions on each individual object, set permissions on the folders.

- Consider using ACTs. ACTs are reusable patterns of settings that you can apply to multiple objects.

- Assign denials to the broadest group (SASUSERS) and then add offsetting grants for users or groups whose access you want to preserve. Deny access at the highest point of control (for example, at the top of the folder tree) and then grant access back on specific containers or objects.
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.